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JustSEARCH Overview
JustSEARCH is a module of the JustIMAGE suite that allows you to open image files easily
without the need to know exactly where these files are physically located.

Concepts

Locations
The  JustSEARCH module  works  by creating an index of  all  image files  held  in  a  given
location. A location is an abstraction of a physical storage of the image file. For example a
shared disc, NAS (disk array), etc.

Locations  and  possible  sub-locations,  in  essence  sub-directories,  are  configured  in  the
JustSEARCH module via the JustSEARCH manager interface.

Attributes
Image files can have various attributes: file name, file type, date created, date modified, etc.
These can also be advanced attributes such as the author name, subject, description, etc.

Attributes have an associated type to put a constraint on the attribute value. For example the
attribute “Published” has the date attribute type.

Attributes are by default optional. You can make an attribute mandatory for the user. If the
user wants to store the file, the mandatory attribute must be given a value.

Attributes  are  configured  in  JustSEARCH via  the  JustSEARCH manager  interface.
JustSEARCH already comes with the most common attributes to simplify the configuration.

Search Index
JustSEARCH works  by creating an index of  all  image files  held in  a  given location.  It's
possible to generate this index in batch by scanning the configured locations. For each image
file found, its location and possible attributes are stored together with a thumbnail of the
image file.

Only files of a given file type are scanned to speed up the overall scanning process. File types
are configured in  JustSEARCH via the  JustSEARCH manager interface.  The  JustSEARCH
module  already  comes  with  the  file  types  supported  by  JustIMAGE to  simplify  the
configuration.
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Server
The JustSEARCH module is a client / server based system where the index, attributes, etc are
maintained by a server. The JustSEARCH Server is accessed through a network connection
by the rest of JustSEARCH.

Note: It's  not  necessary that  server is  installed on another computer.  You can also use
JustSEARCH for personal use if needed as long as that computer is not physically shared
with other users.

Users
The  JustSEARCH Server allows anyone access to the index. However, this does not mean
that anyone has access to individual image files. This is still restricted by the rights system
used by the physical location.

The configuration of attributes, locations, etc as well as the scanning of locations is handled
by the JustSEARCH manager interface. Access to the manager interface is restricted by a user
name / password combination.

Users belong to a group. Currently there are two groups1:

• default: A standard user. These users are added to the system on the fly for ease of
use.

• all:  A user with rights to access the manager related actions. These users must be
manually added to the system.

Store and Retrieve
Storage  and  retrieval  of  files  is  integrated  in  the  Viewer,  JustEDIT and  JustMONTAGE
interfaces of the JustIMAGE suite.

A user can store an individual image file at a location. While storing, a user can specify
values for attributes. The user cannot store an image file when mandatory attributes don't
have a value set. In addition an individual user can specify one or more tags to be associated
with the image file.

To retrieve an image file, the user specifies a search criteria for one or more attributes of a
file. For example a user can specify a partial file name. The JustSEARCH system will return a
list of one or more image files that match the search criteria from which the user can choose.

1 Technically there is a third group “deactivated” which indicate that the users don't have any 
access to the system.
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Common Tasks

Adding Locations
Before the index can be built you need to add at least one location. This can be done in the
JustSEARCH manager interface from the Admin > Locations window.

In general you want to specify locations that are accessible by everyone in your department.
Common practice is to have one or more network shared locations.

Building the Search Index
Building the Search Index in batch can be done through the Index >  Build Search Index
dialog box in the  JustSEARCH manager interface. You must have configured at least one
location before you can build the Search Index.

Search Index Activation
The Store and Retrieve functionality is,  by default, disabled for users when the system is
setup for the first time. After the initial build of the Index, a manager must explicitly activate
the Index. This can be done through the Index >  Activate Search Index dialog box in the
JustSEARCH manager interface.

Backup
The server has its data, including the database, under:

Windows:  C:\ProgramData\Justcroft\jigserver

Linux: <install dir>/jigserver/dta

The  SQLite 3 database  is  jigsrv.db.  In  addition  it's  recommended  to  backup the
thumbnails sub-directory as well as this contains all the preview images.

Intermediate Tasks

Adjusting Attributes
This  can  be  done  in  the  JustSEARCH manager  interface  from  the  Admin  >  Attributes
window.

9



JustSEARCH Overview

Adjusting File Types
This  can  be  done  in  the  JustSEARCH manager  interface  from  the  Admin  >  File Types
window.

Maintaining the Search Index
The Search Index can be updated in batch through the Index >  Check Search Index dialog
box in the JustSEARCH manager interface. 

Adding Managers
This can be done in the JustSEARCH manager interface from the Admin > Users window.

Advanced Tasks

Adding Attributes
This  can  be  done  in  the  JustSEARCH manager  interface  from  the  Admin  >  Attributes
window.

Adding File Types
This  can  be  done  in  the  JustSEARCH manager  interface  from  the  Admin  >  File Types
window.

Deactivating Users
This can be done in the JustSEARCH manager interface from the Admin > Users window.
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Installation and Configuration
You  can  download  the  JustSEARCH  Server software  from  our  support  site  at
support.justcroft.com in the JustIMAGE section of the site. If you do not have a Justcroft
Support  account  user  name  and password,  or  you  tried  it  and  it  doesn't  work,  contact
support@justcroft.com for help.

You are also going to need minimal JustIMAGE 5.2.03 or higher software. Recommended is
JustIMAGE 5.4.00. You can download the  JustIMAGE software also from our support site.
You do not need to install JustIMAGE on the same computer as the server.

Prerequisites
We assume that you are familiar with the Operating System you are going to use and that
you are familiar with installing software. You must also be familiar with Windows Services
or Linux daemon processes depending on the Operating System you are installing the server
software on.

Do not install JustSEARCH Server in a folder where another program or product is already
installed. Also, do not install other programs in the same folder where JustSEARCH Server is
installed. This may cause uninstalling the JustSEARCH Server to fail.

Do not rename any of the sub-directories in the  JustSEARCH Server installation folder or
move the installation folder after installation. Should you wish to move the product to a
different location it is recommended that you uninstall the JustSEARCH Server first and then
reinstall in the new location.

License
The  JustSEARCH Server requires that you have the  JustSEARCH Server license feature as
part of your JustIMAGE license. The license does not need to be installed or configured on
the computer where the JustSEARCH Server software is installed.

System Requirements

Operating System
One of the following 64bits Operating Systems:

• Windows 7 x64. (x64 or compatible.)

• Windows 8/8.1 x64. (x64 or compatible.)
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• Windows 10 x64. (x64 or compatible.)

• Windows Server 2008 R2 x64. (x64 or compatible.)

• Windows Server 2012 R2 x64. (x64 or compatible.)

• Windows Server 2016 x64. (x64 or compatible.)

• Linux RedHat Enterprise 7 64bits. (x86_64 or compatible.)

Privileges
You will need Administrator privileges to install the software and configure the server on
Windows. It  is  recommended to install  the  JustSEARCH Server in a separate account on
Linux. No special account privileges are required.

The  JustSEARCH  Server runs  as  a  service  with  LocalService privilege on  Windows,
following the least-privilege security best practice.

Disk Space
About 55 MB is needed for an installation depending on the OS used. In addition you should
reserve about 20 and 100 Mb of disc space for the database and additional files.

Qt
The  Graphical  User  Interfaces  of  the  JustSEARCH  Server are  written  using  The  Qt
Company's Qt cross platform and UI framework. We deliver the required shared libraries of
Qt with the JustSEARCH Server.

Windows
The Qt dynamic libraries are located under the <install folder>\bin\ sub-folder. The Qt plug-
ins are located under the <install folder>\qt5\plugins\ sub-folder.

It is essential that the  <install folder>\bin\qt.conf file is kept as this is required to locate
the Qt plug-ins.

Linux
The Qt dynamic libraries are located under the <install directory>/qt5/lib/ sub-directory.
The Qt plug-ins are located under <install directory>/qt5/plugins/ sub-directory.

It is essential that the  <install folder>/bin/qt.conf file is kept as this is required to locate
the  Qt  plug-ins.  Important: Some Linux  distributions  have Qt  runtime libraries  installed.
These should not be used as we have made custom patches to the default Qt libraries.
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Linux requires that the  $LD_LIBRARY_PATH environment variable is set in order to locate
the  Qt  dynamic  libraries.  Most  programs  are  actually  shell  scripts  that  set  the
$LD_LIBRARY_PATH to <install directory>/qt5/lib/ before calling the actual executable.

Important: Advanced users may want to directly call a program that is not intended to be run
directly. You will get a fatal error regarding the loading of the first shared library that was
not found.

Database
The JustSEARCH Server uses an SQLite 3 database. The required database driver is delivered
together  with  the  JustSEARCH  Server software.  The  database  structure  is,  if  necessary,
created by the JustSEARCH Server configuration tool.

The SQLite database file name is jigsrv.db and is located in the data directory of the server.

Network Communication
The  JustSEARCH  Server uses  TCP/IP  for  communication  with  the  client  interfaces.  The
communication is handled through the  WebSocket protocol. The  default port used by the
server is 1970. This can be changed with the configuration tool.

The JustSEARCH Server software installation on Windows will automatically configure the
Windows firewall. Access will be set for the local sub-net with TCP/IP as protocol.

You can configure the firewall on RedHat Enterprise using  system-config-firewall.
The firewall must be configured to allow TCP/IP network traffic. The port must match the
network port you are going to use.

Platform Notes

Windows 7
The JustSEARCH Server will only work on the Windows 7 x64 (64bit) releases. The software
has been digitally signed with “Justcroft International Ltd.” as publisher.

You may encounter one or more of the following:

• You  may  get  an  UAC warning  when  running  the  installation.  The  installation
requires  administrative  privileges.  Less  privileged  users  will  be  prompted for  an
administrative account.

• You may get an UAC warning when the Visual Studio run-times are installed.
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Windows 8 / 8.1
The JustSEARCH Server will only work on the Windows 8 x64 and Windows 8.1 x64 (64bit)
releases.  The  software  has  been  digitally  signed  with  “Justcroft  International  Ltd.”  as
publisher.

You may encounter one or more of the following:

• You  may  get  an  UAC warning  when  running  the  installation.  The  installation
requires  administrative  privileges.  Less  privileged users  will  be  prompted for  an
administrative account.

• You may get an UAC warning when the Visual Studio run-times are installed.

Windows 10
The JustSEARCH Server will only work on the Windows 10 x64 (64bit) releases. The software
has been digitally signed with “Justcroft International Ltd.” as publisher.

You may encounter one or more of the following:

• You  may  get  an  UAC warning  when  running  the  installation.  The  installation
requires  administrative  privileges.  Less  privileged users  will  be  prompted for  an
administrative account.

• You may get an UAC warning when the Visual Studio run-times are installed.

Windows Server 2008 R2
The JustSEARCH Server will only work on the Windows Server 2008 R2 x64 (64bit) releases.
The software has been digitally signed with “Justcroft International Ltd.” as publisher.

You may encounter one or more of the following:

• You  may  get  an  UAC warning  when  running  the  installation.  The  installation
requires  administrative  privileges.  Less  privileged users  will  be  prompted for  an
administrative account.

• You may get an UAC warning when the Visual Studio run-times are installed.

Windows Server 2012 R2
The JustSEARCH Server will only work on the Windows Server 2012 R2 x64 (64bit) releases.
The software has been digitally signed with “Justcroft International Ltd.” as publisher.
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You may encounter one or more of the following:

• You  may  get  an  UAC warning  when  running  the  installation.  The  installation
requires  administrative  privileges.  Less  privileged  users  will  be  prompted for  an
administrative account.

• You may get an UAC warning when the Visual Studio run-times are installed.

Windows Server 2016
The JustSEARCH Server will only work on the Windows Server 2016 x64 (64bit) releases. The
software has been digitally signed with “Justcroft International Ltd.” as publisher.

You may encounter one or more of the following:

• You  may  get  an  UAC warning  when  running  the  installation.  The  installation
requires  administrative  privileges.  Less  privileged  users  will  be  prompted for  an
administrative account.

• You may get an UAC warning when the Visual Studio run-times are installed.

Linux
The  JustSEARCH Server is  developed and tested on Linux RedHat Enterprise 7 (x86_64).
You must have X11 installed in order to run the JustSEARCH Server configuration tool. This
version also works on CentOS 7.

Linux requires that the  $LD_LIBRARY_PATH environment variable is set in order to locate
the  Qt  dynamic  libraries.  Most  programs  are  actually  shell  scripts  that  set  the
$LD_LIBRARY_PATH to <install directory>/qt5/lib/ before calling the actual executable.

Important: Advanced users may want to directly call a program that is not intended to be run
directly. You will get a fatal error regarding the load of the first shared library that was not
found.
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Installing on Windows

Preparation
Make sure that you have  Microsoft Windows Installer 4.0 or higher. See also the various
Windows platform notes.

Make sure that you have closed down any important applications before attempting to run
the self-extracting executable.

Running the installation
Run the self-extracting executable. You will be prompted for a (temporary) setup extraction
folder. The default is a sub-folder under %CommonAppData%, but you can change this to a
more suitable location for your situation.

The self-extractor will first unpack the Windows installer files.  The self-extractor will then
start  the  Windows  Installer.  A  log  file  will  be  created  under  %temp%\
jigserver54-release-win64.log, where  %temp% is the location of your temporary files
and release is the release number.

16
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The screen shows you the End-User License Agreement. Please read this carefully and then
select “I accept the terms in the license agreement”. Press the  Install button to start the
installation. You may get the UAC prompt.

The software will be installed under %ProgramFiles%\Justcroft\jigserver.

17
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Installation Information for Scripters
The following information is important for scripters of the  JustSEARCH Server installation
on Windows.

Since the variety of network installations and system configurations is simply too great, we
cannot give full support on all possible deployment requirements. There are several sites on
the Internet that give you hints and tips over how to deploy software.

The JustSEARCH Server software download is a self-extracting executable which contains a
Windows Installer files.  The software has been created using the Microsoft  Visual Studio
2019 libraries and these are also  part  of  the  self-extracting process  and installation.  This
might not be suitable to you should you wish to re-script the installation. You can run the
self-extracting executable with the parameter  /NORUNMSI to prevent the automatic start of
the Windows Installer.  Important: Unlike most Windows executables,  parameters for the
self-extracting executable are case sensitive.

Use the /D=folder parameter to set the path where the MSI file is extracted. This must be the
last parameter used on the command line and must not contain any quotes, even if the path

18
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contains  spaces.  Note  that  the  default  is  to  create  a  folder  under  %CommonAppData%\
Justcroft.

You should not run a capture tool and then make alterations to the captured result. Instead
use the MSI file and load this into your Windows Installer authoring application.

A shortcut to the configuration tool is created on the PC desktop and an entry is made under
the Start menu.

Silent Installation
You can perform a silent installation by specifying the parameter  /S. This will prevent the
user from seeing the installation steps. As an example:

jigserver54-03-win64 /S

Installing on Linux

Preparation
Log into the account in which you want to install the software /home/justcroft.

Important:  Never do the installation as  root!  This should not be necessary as none of the
programs require root access.

Running the installation
Extract the software from the downloaded tarball under the account (/home/justcroft).

tar xvf jigserver54-03-linux64.tar

You are now ready to do the configuration of the server.

Configuration
The  JustSEARCH Server configuration  tool  is  used to  configure  the  directory  where  the
server data is kept, create the default database and start / stop the server.

Windows: You can start  the  JustSEARCH Server configuration tool on Windows by either
clicking on the “JustSEARCH Server Configuration” desktop icon or through the Start menu
> Justcroft JustSEARCH Server > JustSEARCH Server Configuration.

Linux: Go to the /home/justcroft/jigserver/bin directory and run jigconfigure.

19
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Before Starting the Server
On the Service tab you can set the network port used by the server.

20

Illustration 4: The JustSEARCH Server Configuration tool.
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Optionally you can set the data directory where the server data including the database is
kept.

The  default  database is  created,  when not found, when starting the server.  You can also
manually create the default database by going to the Database tab and press the “Create
database” button. You will get a status message that the database is created.

If the database already exists, you can run a sanity check on the database using the “Check
database” button on the Database tab.

21
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Starting the Server

Windows
Windows: Before you can start the server it needs to be installed as a Windows service. This
can be done using the “Install...” button on the Service tab. Once the server is installed you
can start the server by pressing the “Start...” button on the Service tab.

Note: The configuration tool  will  check if  a  database already exists  before starting the
server. A default database is created if necessary.

The server will be configured as an automatic starting service at boot time.

Linux
Click the “Install...” button if the “Start…” button is grayed out. Start the server by pressing
the “Start...” button on the Service tab. Note: The “Install…” button has no effect other than
doing an internal registration.

The  server  can  be  configured as  an  automatic  starting  daemon.  A  template  init.d script
jigserver.rc is  located  under  the  jigserver/setup/misc sub-directory.  See  the
README.rc for how to use this template.

Stopping the Server
The server can be stopped using the “Stop...” button on the Service tab.

Server Log
The server maintains a log file jigserver.log under the <server data directory>\log sub-
directory. You can look at this file should the server not start or appears to malfunction.

An initial start of the server will look like this:
2017-11-08T07:44:56 info justcroft.jig.server: Server 1.027 started.
2017-11-08T07:44:56 info justcroft.jig.server: Using data path:  "C:\\
ProgramData\\Justcroft\\jigserver\\"
2017-11-08T07:45:01 info justcroft.jig.server: Database initialisation 
finished.
2017-11-08T07:45:01 info justcroft.jig.server: Started listening on port:
1970
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JustSEARCH Manager

Starting the JustSEARCH Manager Interface
You can start the  JustSEARCH Manager Interface in the  JustIMAGE 5.4 User Interface by
selecting the “JustSEARCH Manager...” command from the Tools menu.

Windows:  Alternatively  you  can  start  the  interface  from  the  Start  menu  >  Justcroft
JustIMAGE 5.4 > JustSEARCH Manager.

You will be prompted for the host and port on which the JustSEARCH Server resides. You
also have to enter the user name and password.

By default there is one predefined combination of user name and password:  manager with
the password manager. You can change the password by selecting File > User Details…

23
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Illustration 8: The JustSEARCH Manager User Details 
dialog box.
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You can disconnect from the JustSEARCH Server by selecting File > Disconnect….

Index Menu

Build Search Index

Building the Search Index in batch can be done through the Build Search Index dialog box.
You must have configured at least one location before you can build the Search Index.

Select whether you want to add files from all configured locations or a single location. Press
the Start button to begin the process of scanning the locations.

Depending on the number of locations and the number of files in each location this can take
several minutes up to several hours. Only files that are configured as File Type are scanned
and added to the Search Index.

24

Illustration 9: The JustSEARCH Manager Build Index 
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The scan process can be stopped by clicking the Stop button. A report of the scan process can
be generated once it's finished by selecting the Save Report button. You can save the report in
various formats.

Check Search Index
This is a housekeeping option that can be run from time to time. A check of the Search Index
works the same as a Build Search Index except that files that are already part of the Search
Index and have not been changed are not updated in the database.

Activate Search Index
The Store and Retrieve functionality is,  by default, disabled for users when the system is
setup for the first time. After the initial build of the Index, a manager must explicitly activate
the Index.

25
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Select the “Enable the Search Index.” toggle and click on OK to activate the Index.

A manager can also manually deactivate the Index. In this case select the “Disable the Search
Index.” toggle and click OK to deactivate the Index.

Note: Doing a Build Search Index or Check Search Index will always temporarily deactivate
the Index for users to prevent problems due to inconsistencies in the Index.

Admin Menu
You can switch between various administrative windows from the Admin Menu.

26
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Illustration 12: Deactivate the Search Index.
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File Types

You control which files are scanned during the Build Index and Check Index process from
this  window.  In  general  you  do  not  need  to  access  this  window  as  files  supported  by
JustIMAGE 5.4 are already predefined in the default Search Engine database.

To  change  a  description,  select  a  file  type  from  the  list.  Alter  the  description  in  the
Description text field and then click Submit.

To change a file extension or add a file extension, select a file type from the list. Update the
extensions from the File Extensions text field.  Note that extensions must be separated by
commas and that the dot should not be part of the extension.

Advanced: Adding a new File Type. Type in the File Type field the mime type of the file type
you want to add. Note that depending on your OS you will get suggestions for a possible
mime type. The Description text field and File Extensions text field will be automatically
filled in if the mime type is recognized.

Advanced: Removing  a  File  Type.  We  don't  recommend  to  remove  any  of  the  default
configured file types. The only reason you may have to is to reduce the size of the Search
Index.  Select the file type you want to remove from the list and then click the Delete button.

27
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Attributes

The various attributes used by the Search Index are visible in the Attributes window. The
predefined attributes are based on the Dublin Core metadata set.

There are two types of attributes: system attributes which cannot be altered or removed and
non-system (advanced) attributes.

Each attribute has an Id, a (friendly) name, description and type. The Id is used internally by
the Search Engine. The name is how end-users will see the attribute in the various interfaces.
The description is to help the user determine what the attribute is for.

To change the name select an attribute from the list. Alter the name in the Name text field
and then click Submit.

To  change  the  description  select  an  attribute  from  the  list.  Alter  the  description  in  the
Description text field and then click Submit.

You can make an attribute  mandatory for the end-user; that is, the end-user must enter a
value when storing a file in the system. Select an attribute from the list, check the Mandatory
checkbox and then click Submit. You will be prompted for a default value for any files that
are already in the Search Index and who do not have a value for the given attribute yet.

Advanced: Adding an attribute. Consider using one of the predefined attributes before adding
a new attribute. Enter the Id, Name, Description in the text fields. Use the Compose button to
bring up the Attribute Type dialog box.
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Illustration 14: The JustSEARCH Manager Attributes window.
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Select the type of the attribute:

• Any. The user can enter any text value.

• Integer number. The user must enter a whole number. Optionally the number value
range can be constrained with a minimum and / or a maximum.

• Real number. The user must enter a fractional number. Optionally the number value
range can be constrained with a minimum and / or a maximum.

• Date & Time. The user must enter a date and optionally a time.

• User ID. This is an advanced type. The value must match a user who is known in the
system.

• Selection. The user can only select a value from a list  of values configured in the
system. Each selection value can be entered in the Values text field and then clicking
the + button. A selection value can be removed by selecting it from the Values list and
then clicking the – button.
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Illustration 15: The JustSEARCH Manager Attribute 
Type dialog box.
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Click OK to close the Attributes Type dialog box. Optionally you can make the new attribute
mandatory and then click Submit.

Advanced: Removing  an  attribute.  We  don't  recommend  removing  any  of  the  default
configured attributes.  However you can select the attribute you want to remove from the list
and then click the Delete button.

Locations

The Locations window contains the locations you have configured for the system. Locations
are identified by Access URI which is a universal way of specifying physical locations.

In general you want to specify locations that are accessible by everyone in your department.
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Illustration 16: An example of a Selection type.

Illustration 17: The JustSEARCH Manager Locations window.
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Common practice is to have one or more network shared locations.

You are not required to specify each and every sub-directory. The system will scan and add
so called sub-locations when you add or update a location as long as the “Add sub-locations”
checkbox  is  ticked.  Default  sub-locations  are  “hidden”  in  the  list.  Check  the  “Tree
expandable” checkbox if you wan to see the tree structure.

You add a location by entering the Access URI and giving the location a description. Use the
browse button (…) to make entering the value of the Access URI easier. Click the Submit
button to add the location and (when selected) its sub-locations.

If new sub-locations are created you can update the main location by selecting the location
from the list and clicking on the Submit button. The system will check and update the list of
sub-locations if necessary.

Advanced: Removal of a location is only possible if no files are yet associated with it in the
system. Select a location from the list and click on the Delete button.

User Groups

This  window  is  read-only  and  only  for  informational  purposes.  You  cannot  alter  User
Groups.

• All is a group of users who have managing rights in the system.
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Illustration 18: The JustSEARCH Manager User Groups 
window.
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• Default is the standard group any new user of the system is given.

• [deactivated]  is  a  special  group which indicates  that  the user  is  disabled and not
allowed to use the Search Engine.

Users

You don't need to add default users to the system as this will happen automatically. You may
want to set the real name of the user. This can be done by selecting the user from the list,
enter the real name in the Real Name text field and press Submit.

You may want to  add a manager to the system. It's  recommended to use as the User ID
something that's not a login ID to prevent confusion. Give a meaningful real name and make
sure the Role  checkbox has been set.  Now click on Submit.  You will  be prompted for a
password to be used with the manager User ID. Keep in mind that the default password is
the same as the User ID.

Advanced: You  can  set  a  new password  for  a  manager  by  selecting  the  User  ID  of  that
manager and then click the Password button. You will be prompted for a new password2.

The default database has one manager called manager with the password manager

Advanced: You may want to deactivate a user by selecting the User ID from the list and then

2 The default manager has the password manager.
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Illustration 19: The JustSEARCH Manager Users window.
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clicking on Deactivate. A deactivated User Id can be reactivated by selecting the User ID
from the list and then clicking on Reactivate. A user that has been deactivated can no longer
use the system, even as a manager. The system will ensure that at least one manager remains
active to prevent a total lockout of the system.
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How to Store a file
A file can be stored using the  JustSEARCH module.  This  requires  that  the  JustSEARCH
Server is running and can be accessed from your computer.

It could be that the JustSEARCH Server is temporarily deactivated by a manager. In this case
you will not be able to store a file.

This can happen if the system has been disabled for users because of maintenance. You can
try to store if you know that the system will become available very soon. Otherwise you can
wait several minutes and try again.
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Illustration 20: JustSEARCH Server deactivated 
warning when storing.

Illustration 21: The Store dialog box.
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JustSEARCH manager: You can always store a file regardless if the JustSEARCH Server is
active or not. You will also be able to browse for a file and store from within the Store
dialog box.

Viewer/JustEDIT: The store option only becomes available if you have loaded a file in the
interface. Edit will ask first to save the file if necessary.

JustMONTAGE: The  montage  composition  will  be  stored  if  you  use  this  command.
Montage will first ask to save the composition if necessary.

A preview image will be generated and shown if possible. This preview will be stored in the
JustSEARCH Server for use when doing a retrieve.

You  can  enter  one  or  more  attribute  values.  The  built-in  attribute  scanner  will  try  to
determine any attribute it can find if the “autodetect” option is enabled.

JustSEARCH manager: The “clear attributes” option will clear any attribute values when
you browse for another file.

Double-click on the Value field to enter an attribute value. You will be able to enter either
text, numbers, date/time or you have to select a fixed value from a combo-box depending on
the attribute type. Either press the Enter key or click outside the field to finish entering the
value. Use the Escape key to cancel the input. The  JustSEARCH manager may have made
some fields mandatory. In this case you must enter a value.

Tags are comma-separated values you can associate with the file you are storing.

Once you are finished setting the attribute values you can press Store to start the storing
process. Note that you will be asked to enter any mandatory fields for which you may have
forgotten to give a value.
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How to Retrieve a file
A file can be retrieved using the  JustSEARCH module. This requires that the  JustSEARCH
Server is running and can be accessed from your computer.

It could be that the JustSEARCH Server is temporarily deactivated by a manager. In this case
you will not be able to retrieve a file.

This can happen if the system has been disabled for users because of maintenance. You can
try to retrieve if you know that the system will become available very soon. Otherwise you
can wait several minutes and try again.
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Illustration 22: JustSEARCH Server deactivated 
warning when retrieving.

Illustration 23: The Retrieve dialog box.
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Viewer: Montage composition files cannot be retrieved. All the other default File Types can
be retrieved.

JustSEARCH manager: The Retrieve functionality is for testing purposes only. No actual
file will be retrieved. You can always access the Retrieve dialog box regardless whether
the JustSEARCH Server is active or not.

JustEDIT: JustMONTAGE composition  files  cannot  be  retrieved.  All  the  other  default
File Types can be retrieved. Note that the File Type query filter is by default set to CGM.
You must either set it to another File Type or disable the query filter if this is not what you
intended.

JustMONTAGE: Only  JustMONTAGE composition files  can be retrieved. Note that the
File Type query filter is already set to help you with this.

The Retrieve dialog box is roughly divided into two sections. The top half allows you to set
one or more queries  while  the bottom half  shows the result  of  the query.  Note that,  by
default, only the basic queries are shown. Check the Advanced check box to bring up the
advanced table with attributes.

Set  the check box before the query to select the query.  You must set at least one query.
Queries  are  inner  joins  which  means  that  if  you have multiple  queries  everything  must
match the individual query.

The query value you can enter depends on the type of query. Any text field must match the
complete text string. You can use wildcards. Use '*' to match zero or more characters while '?'
will  match  a  single  character.  For  example  if  you  enter  ben*.cgm, this  will  match
benseis.cgm.

Dates can be entered either as an exact date, any date before the given date, any date after the
given date or between two dates. Note that dates are stored in the system as UTC date/times
to prevent ambivalence.

38

Illustration 24: The advanced attribute query table.
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Original user and Last user are ids that are stored by the system. You can use wildcards for
these as well.

Tags are comma-separated values that were entered when a file was stored.

Advanced  attribute  queries  can  be  used  by  selecting  the  check  box  before  the  name.
Depending on the attribute type you can set an operator. The query value should be entered
in the first  Value column by double-clicking the value cell.  The second Value column is
usually disabled except when a range selection is made for numbers or a date.

Select With Preview if you want a small preview image in the result of the search query.
Having a preview does slow down the query. Press Find to start the query. This can take a
second to a couple of seconds depending on the complexity of the query and whether you
had selected With Preview.

Select the file you want to load and press Retrieve to load it in the main interface. Note that
the dialog box will stay open until you select Close3.

3 Except in the JustSEARCH manager. The dialog box will close in this interface.
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Illustration 25: An example query result when doing a retrieve.
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